Installation of SAP Library for SAP systems based on SAP NetWeaver 7.0 and Higher on Windows
# Content

1. **About this Document** .......................................................... 5

2. **Variants of SAP Library** ....................................................... 7
   2.1 HtmlHelpFile ................................................................. 8
   2.2 PlainHtmlHttp ............................................................... 9
   2.3 PlainHtmlFile ............................................................... 10
   2.4 DynamicHelp ............................................................... 10
   2.5 Criteria for Selecting the Help Type ................................. 11

3. **Installation** ........................................................................ 13
   3.1 Installing HtmlHelpFile .................................................. 14
   3.2 Installing PlainHtmlHttp and PlainHtmlFile ..................... 15
   3.3 Installation of Help Files Using Software Provisioning Manager 16
       Preparations for the Installation with Software Provisioning Manager . 17
       Installing and Updating SAP Library Using Software Provisioning Manager . 27

4. **Post-Installation** ................................................................. 32
   4.1 Using a Web Browser or Viewer ........................................ 32
   4.2 Offline Access to Help Files - SAP Library Navigation .......... 33
   4.3 Setting Variants for SAP Library ....................................... 34

5. **Additional Information** ....................................................... 37
   5.1 About the Installer ........................................................... 37
       Useful Information About the Installer .................................. 37
       Performing a Remote Installation (Java SDT GUI only) ........... 38
       Starting the Java SDT GUI Separately .................................. 40
       Interrupted Processing of the Installer .................................. 42
       Running the Installer in Accessibility Mode .......................... 45
       Troubleshooting with the Installer ...................................... 46
   5.2 Local Override of Help Settings on Front Ends .................... 47
       File sapdoccd.ini ............................................................. 47
       Parameters in File sapdoccd.ini ......................................... 48
       Logging of Help Calls ....................................................... 50
The following table provides an overview on the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6</td>
<td>2017-09-11</td>
<td>Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>2.5</td>
<td>2017-05-22</td>
<td>Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>2.4</td>
<td>2017-02-06</td>
<td>Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>2.3</td>
<td>2016-10-07</td>
<td>Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>2.2</td>
<td>2016-06-06</td>
<td>Updated version for software provisioning manager 1.0 SP17 (SL Toolset 1.0 SP17)</td>
</tr>
<tr>
<td>2.1</td>
<td>2016-02-15</td>
<td>Updated version for software provisioning manager 1.0 SP10 (SL Toolset 1.0 SP16)</td>
</tr>
<tr>
<td>2.0</td>
<td>2015-10-12</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP15)</td>
</tr>
<tr>
<td>1.9</td>
<td>2015-09-14</td>
<td>Updated version for software provisioning manager 1.0 SP09 (SL Toolset 1.0 SP14)</td>
</tr>
<tr>
<td>1.8</td>
<td>2015-04-27</td>
<td>Updated version for software provisioning manager 1.0 SP08 (SL Toolset 1.0 SP13)</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1.7</td>
<td>2014-11-24</td>
<td>Updated version for software provisioning manager 1.0 SP07 (SL Toolset 1.0 SP12)</td>
</tr>
<tr>
<td>1.6</td>
<td>2014-07-07</td>
<td>Updated version for software provisioning manager 1.0 SP06 (SL Toolset 1.0 SP11)</td>
</tr>
<tr>
<td>1.51</td>
<td>2014-04-11</td>
<td>Updated version for software provisioning manager 1.0 SP05 (SL Toolset 1.0 SP10)</td>
</tr>
<tr>
<td>1.5</td>
<td>2014-03-17</td>
<td>Updated version for software provisioning manager 1.0 SP05 (SL Toolset 1.0 SP10)</td>
</tr>
<tr>
<td>1.4</td>
<td>2013-07-23</td>
<td>Updated Version</td>
</tr>
<tr>
<td>1.3</td>
<td>2013-07-15</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.2</td>
<td>2012-12-20</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.1</td>
<td>2012-09-28</td>
<td>Updated version</td>
</tr>
<tr>
<td>1.0</td>
<td>2012-08-06</td>
<td>Initial version</td>
</tr>
</tbody>
</table>
1 About this Document

This guide explains how to install or update SAP Library for SAP systems based on SAP NetWeaver using the installation tool software provisioning manager 1.0 SP21 ("installer" for short), which is part of SL Toolset 1.0 SP21.

The SAP NetWeaver-based system products and releases for which this documentation is valid are listed in SAP Note 1680045.

SAP Library is an HTML-based solution for online documentation. It provides the basis for context-sensitive application help and also includes the SAP glossary. The contents of SAP Library can be displayed in a Web browser on all front-end platforms supported by SAP. SAP Library is available in several different variants; the installation of each of these variants is described in its own topic:

- Installing HtmlHelpFile [page 14]
- Installing PlainHtmlHttp and PlainHtmlFile [page 15]
- Separately from the installation, you can also override the help settings on the front end: Local Override of Help Settings on Front Ends [page 47]

Software Provisioning Manager 1.0

Software provisioning manager is the successor of the product- and release-specific delivery of provisioning tools, such as SAPinst. Before you perform an installation or system copy, we recommend that you always download the latest version of the software provisioning manager [page 17] which is part of the Software Logistics Toolset (SL Toolset for short). This way, you automatically get the latest SAPinst version including latest fixes in the tool and supported processes. For more information about software provisioning manager as well as products and releases supported by it, see SAP Note 1680045.

As a result, SAPinst has been renamed to software provisioning manager ("installer" for short) in this documentation.

However, the term “SAPinst” is still used in:

- Texts and screen elements in the software provisioning manager GUI
- Naming of executables, for example sapinst.exe

Prerequisites

You have received the DVD/CD set of SAP Library. We deliver the online help on these DVDs/CDs in two formats: standard HTML (Plain HTML) and compiled HTML (HTML help). Subdirectories contain the different language versions.
Implementation Considerations

On Microsoft Windows front ends, at least SAP GUI 7.10 must be installed to enable access to the documentation from the SAP system. For more information, see SAP Note 66971.

**Note**

See also the information in the README.TXT file on the Documentation DVD (see Preparing the Installation Media [page 17]).

If you have any problems installing or displaying SAP Library, create a customer message on SAP Service Marketplace under the quick link message. Use the component BC-DOC-IWB-DIS for any issues relating to static help or the component KM-KW for any issues relating to dynamic help.

SAP Notes for the Installation

You must read SAP Note 1261881 before you start the installation. This SAP Note contains the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at http://service.sap.com/notes.
2 Variants of SAP Library

To handle the demands and features presented by different front-end platforms, the HTML-based online help is provided in several variants (help types). The main differences between the help types are the storage format (Standard HTML or Compiled HTML), the way you access the help documents (Web server or file server), and the search and print functions.

Table 2: Help Types

<table>
<thead>
<tr>
<th></th>
<th>HtmlHelpFile</th>
<th>PlainHtmlHttp</th>
<th>PlainHtmlFile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front-end platforms</td>
<td>All Windows platforms supported by Microsoft</td>
<td>All</td>
<td>All Windows platforms supported by Microsoft</td>
</tr>
<tr>
<td>File format</td>
<td>Compiled HTML</td>
<td>Standard HTML</td>
<td>Standard HTML</td>
</tr>
<tr>
<td>Accessed from</td>
<td>File server</td>
<td>Web server</td>
<td>File server</td>
</tr>
<tr>
<td>Displayed in</td>
<td>HTML Help Viewer (installation of Microsoft Internet Explorer required)</td>
<td>Web browser (Microsoft Internet Explorer or Netscape)</td>
<td>Web browser (Microsoft Internet Explorer or Netscape)</td>
</tr>
<tr>
<td>Global full-text search</td>
<td>X (from SAP Help Portal at [<a href="http://help.sap.com%5C">http://help.sap.com\</a>](<a href="http://help.sap.com)%5C">http://help.sap.com)\</a>) (launched, for example, from the banner of the DVD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local full-text search</td>
<td>X (in CHM file)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing of single topics</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Printing of multiple topics</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supported operating sys-</td>
<td>Microsoft Windows</td>
<td>IBM AIX</td>
<td>IBM AIX</td>
</tr>
<tr>
<td>tems for the help instal-</td>
<td></td>
<td>HP-UX</td>
<td>HP-UX</td>
</tr>
<tr>
<td>lation</td>
<td></td>
<td>Sun Solaris</td>
<td>Sun Solaris</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Linux</td>
<td>Linux</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft Windows</td>
<td>Microsoft Windows</td>
</tr>
</tbody>
</table>

i Note

Customers using SAP Knowledge Warehouse can call both SAP documentation and their own custom-made documentation dynamically from SAP KW (help type DynamicHelp).
Related Information

HtmlHelpFile [page 8]
PlainHtmlHttp [page 9]
PlainHtmlFile [page 10]
DynamicHelp [page 10]
Criteria for Selecting the Help Type [page 11]

2.1 HtmlHelpFile

Use

This help type stores documents in Compiled HTML format (*.CHM). They are accessed from a file server and displayed in the HTML Help Viewer. Compiled HTML is a format developed by Microsoft for storing HTML files in compressed form. CHM files require about one-tenth of the disk space required for uncompressed HTML files and about the same space as required for WinHelp files. HTML Help Viewer was introduced by Microsoft as a successor to WinHelp. It is based on the Internet Explorer.

Features

- Can be used only on Windows front-end platforms
- Documents can be accessed directly from the DVD
- Documents are displayed in HTML Help Viewer (requires Microsoft Internet Explorer)
- Navigation in structures and from hyperlinks
- Full text search in the documents in the current help file (local search)
- Multiple documents within the same structure can be printed simultaneously.

System Requirements

Front-End Requirements for HtmlHelpFile

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 2000</td>
<td>Pentium 233 MHz (300 MHz recommended) 1 GB RAM</td>
</tr>
<tr>
<td>Microsoft Windows 2003</td>
<td>Pentium 233 MHz (300 MHz recommended) 1 GB RAM</td>
</tr>
</tbody>
</table>
### Operating System Requirements

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows XP</td>
<td>Pentium 233 MHz (300 MHz recommended)</td>
</tr>
<tr>
<td></td>
<td>1 GB RAM</td>
</tr>
<tr>
<td>Microsoft Windows VISTA</td>
<td>Pentium 2.00 GHz (3.00 GHz recommended)</td>
</tr>
<tr>
<td></td>
<td>1 GB RAM (2 GB recommended)</td>
</tr>
<tr>
<td>Microsoft Windows 7</td>
<td>Pentium 2.00 GHz (3.00 GHz recommended)</td>
</tr>
<tr>
<td></td>
<td>1 GB RAM (2 GB recommended)</td>
</tr>
</tbody>
</table>

### Server Requirements for HtmlHelpFile

See [Hardware and Software Requirements](#) [page 17].

### 2.2 PlainHtmlHttp

#### Use

This help type stores documents in Standard HTML format. They are available from a Web server and can be displayed in a standard Web browser.

#### Features

**Characteristics**

- Can be used on all front-end platforms
- Documents displayed with a standard Web browser (Microsoft Internet Explorer or Netscape)
- Full-text search in all SAP documents from the help portal [http://help.sap.com](http://help.sap.com)
- Navigation in structures (tables of contents) and from hyperlinks
- Printing of single help documents

#### System Requirements

<table>
<thead>
<tr>
<th></th>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front end</td>
<td>No requirements other than those of the Web browser</td>
</tr>
<tr>
<td>Server</td>
<td>See <a href="#">Hardware and Software Requirements</a> [page 17].</td>
</tr>
</tbody>
</table>
2.3 PlainHtmlFile

Use

This help type stores documents in Standard HTML format. They are available from a file server and can be displayed in a standard Web browser.

Features

Characteristics

- Can be used on all front-end platforms
- Documents displayed with a standard Web browser (Microsoft Internet Explorer or Netscape)
- Navigation in structures (tables of contents) and from hyperlinks
- Printing of single help documents

System Requirements

Table 5: System Requirements for PlainHtmlFile

<table>
<thead>
<tr>
<th>System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front end</td>
</tr>
<tr>
<td>No requirements other than those</td>
</tr>
<tr>
<td>of the Web browser</td>
</tr>
<tr>
<td>Server</td>
</tr>
<tr>
<td>Between 850 MB (Microsoft Windows</td>
</tr>
<tr>
<td>NT) and 2 GB (UNIX) of free disk</td>
</tr>
<tr>
<td>space for each language version,</td>
</tr>
<tr>
<td>depending on the file system</td>
</tr>
</tbody>
</table>

2.4 DynamicHelp

The help type DynamicHelp can be used on all front-end platforms. Like the PlainHtml help types it uses a standard HTML file format, and a standard Web browser for viewing. Before you can launch DynamicHelp, SAP Knowledge Warehouse must be installed in the system landscape. Files are accessed through SAP IKS (Internet Knowledge Servlet). The content itself is stored on a content server, which means you do not need to install the help files.
To display the correct information from DynamicHelp, you must set the correct target context in the SAP system. For more information, see SAP Note 594231. This context must also be defined in the SAP Knowledge Warehouse system.

2.5 Criteria for Selecting the Help Type

The decision about which help type to install in a given SAP system mainly depends on the operating system of the front-end clients.

- If you use front ends on Microsoft Windows only, we recommend that you install the help type HtmlHelpFile. This help type offers more extensive search and print functions than the other two help types. However, you are free to install any help type.

  **Note**

  If you are using different front-end platforms in parallel, and therefore have to choose a help type other than HtmlHelpFile, you can still use the help type HtmlHelpFile. For more information, see Local Override of Help Settings on Front Ends [page 47] on clients running on Microsoft Windows.

- If you use front-end platforms other than Microsoft Windows, we also recommend that you install PlainHtmlHttp, since this help type provides a full-text search function from the SAP help portal.

- If you do not have a Web server and you use front-end platforms other than Microsoft Windows, you must use help type PlainHtmlFile.

- If you want to access SAP documentation from both SAP GUI for Windows (Win GUI) and SAP GUI for HTML (Web GUI), or from a browser-based SAP application, you cannot use help type HtmlHelpFile.
The following figure helps you to choose the correct help type:

```
Front End is on Microsoft Windows 98/NT/2000/XP/VISTA/7

Yes

<table>
<thead>
<tr>
<th>Front End is on Microsoft Windows 98/NT/2000/XP/VISTA/7</th>
<th>HtmlHelpFile</th>
</tr>
</thead>
</table>

No

<table>
<thead>
<tr>
<th>Web Server Available</th>
<th>PlainHtmlHelp</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>PlainHtmlFile</td>
</tr>
</tbody>
</table>
```
3 Installation

When you install the SAP Library, you provide the users of your SAP systems with the entire help documentation online.

Prerequisites

You have received the online documentation medium for your SAP product. We deliver the online help on this medium in the following file formats: Standard HTML and Compiled HTML (HTMLHelpFile). Subdirectories contain the different language versions.

Process Flow

For online access from the SAP system, both formats require you to perform the following steps:

1. **Note**
   
   For the sake of simplicity we refer to software provisioning manager 1.0 as “software provisioning manager” or – if suitable – simply as “installer” in the following.

   You install the help files in one of the following ways:
   
   - You install the HtmlHelpFile either manually or using software provisioning manager as described in Installing HtmlHelpFile [page 14].
   - You install the PlainHtmlHttp and PlainHtmlFile using software provisioning manager as described in Installing PlainHtmlHttp and PlainHtmlFile [page 15].

2. You maintain setting variants for the online help in transaction SR13 as described in Setting Variants for SAP Library [page 34].

Result

Once you have completed these steps, you can access SAP Library both online in the SAP system and offline when you have no connection to the system.
3.1 Installing HtmlHelpFile

Use

This procedure describes how you install `HtmlHelpFile`. The Compiled HTML files for help type `HtmlHelpFile` can be viewed directly from the online documentation medium in Microsoft HTML Help Viewer. For better performance, copy the help files to your local hard disk or to a file server (as described in the procedure below).

You can also use software provisioning manager ("installer" for short) to install the `HtmlHelpFile`. If you want to do this, do not follow the procedure below but instead proceed as described in Installation of Help Files Using Software Provisioning Manager [page 17].

—we Recommendation

We strongly recommend that you install the `HtmlHelpFile` with software provisioning manager.

Prerequisites

- To install SAP Library, you require the online documentation medium (see Preparing the Installation Media [page 17]).
- To display the documentation, a suitable browser or viewer must be installed on your computer, as described in Using a Web Browser or Viewer [page 32].

Procedure

1. Create a directory on your file server for the help files. This called the documentation directory. Approximately 2 GB of disk space is needed for the English and German language versions.
2. Insert the appropriate media into the media drive.
3. Copy the directory `HTMLHELP\<language key>` with all its subdirectories from the DVD to the documentation directory on the server.
4. Share the directory.

Result

You have installed SAP Library. Once you have maintained the setting variants in transaction SR13, you can access the documentation both from the SAP system and offline. When you maintain setting variants, you define which help variants are available to the user. For more information, see Setting Variants for SAP Library [page 34].
3.2 Installing PlainHtmlHttp and PlainHtmlFile

Use

This procedure describes how to install PlainHtmlHttp or PlainHtmlFile. The Standard HTML files for help types PlainHtmlHttp and PlainHtmlFile are stored in a packed format in the archive PLAINHTM.SAR on the DVD. They cannot be viewed directly from the DVD but must first be unpacked to the local hard drive or on a file server. To install the help files, you must use software provisioning manager as described in Installation of Help Files Using the Software Provisioning Manager [page 17].

⚠️ Caution

The complete installation comprises about 200,000 files in about 100,000 directories for one language version. Depending on the file system and the configuration of the hard disk, they require up to 850 MB of disk space.

Prerequisites

To install SAP Library, you require the Documentation DVD. To display the documentation, a suitable browser or viewer must be installed on your computer. For more information, see Using a Web Browser or Viewer [page 32].

ℹ️ Note

When you call the search function from the banner of the relevant documentation DVD, an Internet connection is opened enabling a full text search from the DVD. To use the full text search function, you need an Internet connection.

ℹ️ Note

If Java scripting is not enabled, the button for the full-text search function appears in the browser banner even though this function is only available with help type PlainHtmlHttp. If you choose the button, an error message appears. To remove the button from the banner when using PlainHtmlFile, enable Java scripting in your browser settings as follows:

For Microsoft Internet Explorer 5.01 (or later), choose level Medium or Low from the Internet option Security in the Local intranet zone.

Procedure

Install PlainHtmlHttp and PlainHtmlFile using software provisioning manager as described in Installation of Help Files Using Software Provisioning Manager [page 17].
**Result**

The archive `PLAINHTM.SAR` is unpacked and the help files are written to the Web server. This takes about 30 minutes, depending on the operating system and the data transfer rate of the DVD drive. The directory tree created on the Web server when you install the English language version has the following structure:

```
<InstallDir>
- PLAINHTM
+ EN (help files, English version)
```

**Note**

For PlainHtmlHttp, you must create the alias `/saphelp`. Define this alias to point to your installation directory `<InstallDir>`. The Web server requires read access for `/saphelp`.

You have installed SAP Library. Once you have maintained the setting variants in transaction SR13, you can access the documentation both from the SAP system and offline. When you maintain setting variants, you define which help variants are available to the user. For more information, see Setting Variants for SAP Library [page 34]

### 3.3 Installation of Help Files Using Software Provisioning Manager

**Related Information**

Preparations for the Installation with Software Provisioning Manager [page 17]
Installing and Updating SAP Library Using Software Provisioning Manager [page 27]
3.3.1 Preparations for the Installation with Software Provisioning Manager

You have to perform the following steps to prepare the installation or update of the SAP Library with software provisioning manager ("installer" for short).

**Procedure**

1. Check that your installation host meets the hardware and software requirements [page 17].
2. Make sure that the required installation media [page 17] are available.

**3.3.1.1 Hardware and Software Requirements**

Make sure that your host meets the hardware and software requirements:

- **Minimum RAM:**
  - 0.5 GB
- **Minimum disk space:**
  - 2.2 GB in the help destination directory
  - Approximately 600 MB of disk space are required for one language version (Windows NTFS)
  - 4.3 GB of temporary disk space for every required installation medium that you have to copy to a local hard disk
  - 1.2 GB of temporary disk space for the installation
- For supported operating system releases, see the Product Availability Matrix at http://service.sap.com/pam/.

**Caution**

You cannot install SAP Library help files on a Microsoft FAT32 file system because this file system cannot handle the large number of files and directories. If your web server runs on Microsoft Windows, do not install the help documentation on the system partition. Instead, choose another partition.

**3.3.1.2 Preparing the Installation Media**

This section describes how to prepare the installation media.

Installation media are available as follows:

- The Software Provisioning Manager 1.0 archive containing the installer
  - You always have to download the latest version of the Software Provisioning Manager 1.0 archive.
The media containing the software to be installed, which are available as follows:

- You can use the physical installation media as part of the installation package as described in Using the Physical Media from the Installation Package [page 20].
- You download the complete installation media as described in Downloading Installation Media [page 21].

**Note**

The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060.

For more information about which kernel version to use, see SAP Note 1680045. In addition, check the Product Availability Matrix at: [http://support.sap.com/pam](http://support.sap.com/pam).

### Related Information

- Downloading and Extracting the Software Provisioning Manager Archive [page 18]
- Downloading Installation Media [page 21]
- Using the Physical Media from the Installation Package [page 20]

### 3.3.1.2.1 Downloading and Extracting the Software Provisioning Manager Archive

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

### Procedure

1. Download the latest version of the Software Provisioning Manager 1.0 archive
   \[70\]SWPM10SP\<Support_Package_Number\>_\<Version_Number\>.SAR from:
   - Valid for SAP systems based on SAP NetWeaver 7.0 and SAP NetWeaver 7.0 including enhancement package \<Number\>:
     - Download the \[70\]SWPM10SP\<Support_Package_Number\>_\<Version_Number\>.SAR
   - Valid for SAP systems based on SAP NetWeaver 7.1 and higher:
     - Download the SWPM10SP\<Support_Package_Number\>_\<Version_Number\>.SAR

   [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) \(\rightarrow\) SUPPORT PACKAGES & PATCHES \(\rightarrow\) By Alphabetical Index (A-Z) \(\rightarrow\) S \(\rightarrow\) SOFTWARE PROVISIONING MANAGER

2. Get the latest version of the SAPCAR tool on the host where you want to run the installer:
a. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES and search for “sapcar”.

b. Select the archive file for your operating system and download it to an empty directory.

c. To check the validity of the downloaded executable, right-click the executable and choose Properties. On the Digital Signatures tab you can find information about the SAP signature with which the executable was signed.

d. Rename the executable to sapcar.exe.

For more information about SAPCAR, see SAP Note 212876.

3. Using the latest version of SAPCAR, you can verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive as follows:

   a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:

      1. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES and search for “sapcryptolib”.

      2. Select the archive file for your operating system and download it to the same directory where you have put the SAPCAR executable.

      3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where you have put the SAPCAR executable:

          `sapcar -xvf sapcryptolibp_84...sar -R <target directory>`

      4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/crlbag.p7s and move it into the same directory.

   b. Verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive by executing the following command:

       `<Path to SAPCAR>\sapcar.exe -tvVf <Path to Download Directory> \[70]SWPM10SP<Support_Package_Number>_<Version_Number>.SAR -crl <file name of revocation list>`

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:

   `<Path to SAPCAR>\sapcar.exe -xvf <Path to Download Directory> \[70]SWPM10SP<Support_Package_Number>_<Version_Number>.SAR <Path to Unpack Directory>`

   i Note

   Make sure that all users have read permissions for the directory where you want to unpack the installer.

   Caution

   Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.
3.3.1.2.2 Using the Physical Media from the Installation Package

This section describes how you use the physical installation media as part of the installation package.

Procedure

1. Identify the required media for your installation as listed below.

   Table 6:

<table>
<thead>
<tr>
<th>Installation Media</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Provisioning Manager 1.0 archive</td>
<td>○ Depending on your release, download one of the following:</td>
</tr>
<tr>
<td></td>
<td>○ SAP NetWeaver 7.0 / 7.0 including EHPs:</td>
</tr>
<tr>
<td></td>
<td>70SWPM1OSP&lt;Support Package_Number&gt;_&lt;Version_Number&gt;.SAR</td>
</tr>
<tr>
<td></td>
<td>○ SAP NetWeaver 7.1 and higher:</td>
</tr>
<tr>
<td></td>
<td>SWPM1OSP&lt;Support Package_Number&gt;_&lt;Version_Number&gt;.SAR</td>
</tr>
<tr>
<td></td>
<td>○ Documentation medium: &lt;SAP_Product&gt; Support Package Stack &lt;Number&gt; HTML-Help for &lt;OS&gt; Standard HTML (Plain HTML) Number &lt;Material_Number&gt;</td>
</tr>
<tr>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td>SAP NetWeaver 7.5 Support Package Stack 04 HTML-Help for Windows Standard HTML (Plain HTML) Number 50108701</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Documentation medium</th>
<th>&lt;SAP_Product&gt; Support Package Stack &lt;Number&gt; HTML-Help for &lt;OS&gt; Standard HTML (Plain HTML) Number &lt;Material_Number&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td>SAP NetWeaver 7.5 Support Package Stack 04 HTML-Help for Windows Standard HTML (Plain HTML) Number 50108701</td>
</tr>
</tbody>
</table>

2. Make the installation media available on the installation host as follows:
   a. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 18].
b. Make the media containing the software to be installed available.

You can do this in one of the following ways:

○ Copy the required media folders directly to the installation host.
○ Mount the media on a central media server that can be accessed from the installation hosts.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.</td>
</tr>
<tr>
<td>○ If the user does not yet exist, you have to create the user manually before you install the SAP system.</td>
</tr>
</tbody>
</table>

### 3.3.1.2.3 Downloading Installation Media

This section describes how you download media from the SAP Software Download Center.

#### Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager Archive [page 18].
2. Identify all download objects that belong to one medium according to one of the following:

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation media might be split into several files. In this case, you have to reassemble the required files after the download.</td>
</tr>
</tbody>
</table>

○ Download path or location:

○ To download the complete kernel media, go to [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset) ➤ System Provisioning ➤ Software Provisioning Manager 1.0 SP<Current Version> ➤ Download Kernel releases delivered for SL Toolset ➤ SL TOOLSET 1.0 (INSTALLATIONS AND UPGRADES) ➤ KERNEL FOR INSTALLATION/SWPM.

○ To download all media required for your SAP product, you can use one of the following navigation paths:


○ Material number
All download objects that are part of an installation medium have the same material number and an individual sequence number:

<Material_Number>_<Sequence_Number>

Example

51031387_1
51031387_2
...

Title

All objects that are part of an installation medium have the same title, such as <Solution><Media_Name><OS> or <Database>RDBMS<OS> for database media.

3. Download the objects to the download directory.

4. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.

In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note 1258173.

Caution

Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder where you unpack the Software Provisioning Manager archive.

Do not unpack installation media to the same folder where you unpack the SAP kernel archives for archive-based installation.

3.3.1.3 Required User Authorization for Running the Installer

Although the installer automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization before you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

Procedure

Caution

Do not use the user <sapsid>adm for the installation of the SAP system.
Domain Installation

For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

Local Installation

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

Caution

Do not use the Windows built-in account Administrator or the renamed built-in account to install your SAP system. The built-in account only has restricted network access rights that are required by the installer. If you renamed the built-in account Administrator, do not create a new account named Administrator.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

Related Information

Performing a Domain Installation Without Being a Domain Administrator [page 23]

3.3.1.4 Performing a Domain Installation Without Being a Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for Running the Installer [page 22]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the
domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using the installer or manually:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapsid>adm and SAPService<SAPSID>.
3. Add the users <sapsid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

**Note**

The installer creates the operating system user for the SAP Host Agent by default as a local user that is not a member of the local Administrators group. If you want to create this user manually as a domain user, you must perform the following steps:

Creating the SAP Host Agent User and Group Manually

However, for security reasons we strongly recommend you to create this user as a local user.

**Prerequisites**

- You must be domain administrator to perform the required steps.
- You must have installed the feature Remote Server Administration Tools as follows:
  - Windows Server 2012 (R2) and higher:
    - Open PowerShell in elevated mode, and enter the following command:
      `add-windowsfeature RSAT-ADDS`
  - Windows Server 2008 (R2):
    2. In the Server Manager window, select Features.

**Procedure**

Creating the Required Users and Groups Using the Installer

Creating the Required Users and Groups Manually

**Note**

To create the users and groups specific to the SAP Host Agent, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin
Perform the following steps:

- **Windows Server 2012 (R2) and higher:**
  
  Open PowerShell in elevated mode, and enter the following command:
  
  `net group SAP_<SAPSID>_GlobalAdmin /add /domain`

- **Windows Server 2008 (R2):**
  
  1. Log on as domain administrator.
  2. Start the **Active Directory Users and Computers Console** by choosing:
     
     ![Start ➤ Control Panel ➤ Administrative Tools ➤ Active Directory Users and Computers](image)
  3. Right-click **Users** in **Tree**, and choose ![New ➤ Group](image)
  4. Enter the following:
     
     **Group name:** SAP_<SAPSID>_GlobalAdmin
  5. Select the following:
     
     1. **Group scope:** Global
     2. **Group type:** Security
  6. Choose **OK**.

**Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>**

Perform the following steps:

- **Windows Server 2012 (R2) and higher:**
  
  1. Open PowerShell in elevated mode.
  2. Create the `<sapsid>adm` user with the following command:
     
     `net user <sapsid>adm <Password> /add /domain`
  3. Create the SAPService<SAPSID> user with the following command:
     
     `net user SAPService<SAPSID> <Password> /add /domain`

- **Windows Server 2008 (R2):**
  
  1. In **Active Directory Users and Computers Console**, right-click **Users** in **Tree** and choose:
     
     ![New ➤ User](image)
  2. Enter the following:

     **Table 7:**

     | Field     | Input for `<sapsid>adm` | Input for SAPService<SAPSID> |
     |-----------|-------------------------|-----------------------------|
     | First name| None                    | None                        |
     | Initials  | None                    | None                        |
     | Last name | None                    | None                        |

  3. Choose **Next** and enter the following:

     **Password:** `<Password>`
     
     **Confirm password:** `<Password>`
  4. Select **Password never expires**.

**Note**

Make sure that no other options are selected.
5. Choose Next > Finish.

Adding the Manually Created Users to Groups

**Note**

To add the users specific to the SAP Host Agent to the relevant groups, you must follow the procedure below, and replace the users and groups with those for the SAP Host Agent.

**Adding the `<sapsid>adm` User to the `SAP_<SAPSID>_GlobalAdmin` Group**

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```bash
  net group SAP_<SAPSID>_GlobalAdmin `<sapsid>adm` /add /domain
  ```
- Windows Server 2008 (R2):
  1. In the **Users** folder, double-click the newly created user account `<sapsid>adm` in the list on the right.
  2. Choose **Member > Add**.
  3. Select the new `SAP_<SAPSID>_GlobalAdmin` group and choose Add to add it to the list.
  
  **Note**
  By default, the user is also a member of the Domain Users group.

  4. Choose OK twice.

**Adding the `SAPService<SAPSID>` User to the `SAP_<SAPSID>_GlobalAdmin` Group**

- Windows Server 2012 (R2) and higher:
  Open PowerShell in elevated mode, and enter the following command:
  ```bash
  net group SAP_<SAPSID>_GlobalAdmin SAPService<SAPSID> /add /domain
  ```
- Windows Server 2008 (R2):
  1. In the **Users** folder, double-click the newly created user account `SAPService<SAPSID>` in the list on the right.
  2. Choose **Member > Add**.
  3. Select the new `SAP_<SAPSID>_GlobalAdmin` group.
  4. Choose Add to add it to the list, and then OK.
  5. Choose OK to close `SAPService<SAPSID>Properties`.
  6. Close the **Active Directory Users and Computers Management Console**.
3.3.2 Installing and Updating SAP Library Using Software Provisioning Manager

This procedure tells you how to install and update SAP Library with software provisioning manager (“installer” for short).

Prerequisites

- The installation host meets the hardware and software requirements for the SAP Library installation as described in Hardware and Software Requirements [page 17].
- The required installation media are available on the installation host as described in Preparing the Installation Media [page 17].

Context

- Install means that you install SAP Library from scratch.
- Update means that you update an existing version of SAP Library.

Procedure

1. Make sure that the installation host meets the prerequisites for running the installer.
   Fore more information, see Prerequisites for Running the Installer [page 27].
2. Run the installation or update.
   Fore more information, see Running the Installer (Software Provisioning Manager) [page 28]

3.3.2.1 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

- If you want to use the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI: Google Chrome, Mozilla Firefox, Microsoft Edge, or Microsoft Internet Explorer 11. Always use the latest version of these web browsers.

  ➤ Recommendation
  We recommend using Google Chrome.
If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the SL Common GUI.

For more information about the SL Common GUI, see Useful Information About the Installer [page 37].

- You need at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the installer executables.
- Make sure that the following ports are not used by other processes:
  - When using the SL Common GUI:
    - Port 4237 is used by default as HTTPS port for communication between the installer and the SL Common GUI.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTPS_PORT=<Free Port Number>`
    - Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
      The filled-out evaluation form is then sent to SAP using HTTPS.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTP_PORT=<Free Port Number>`
  - When using the Java SDT GUI:
    - Port 21212 is used by default for communication between the installer GUI server and the installer GUI client.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_DIALOG_PORT=<Free Port Number>`
    - Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
      The filled-out evaluation form is then sent to SAP using HTTPS.
      If this port cannot be used, you can assign a free port number by executing `sapinst.exe` with the following command line parameter:
      `SAPINST_HTTP_PORT=<Free Port Number>`

### 3.3.2.2 Running the Installer

This section describes how to run the installation tool Software Provisioning Manager 1.0 (the “installer” for short).

### Prerequisites

For more information, see Prerequisites for Running the Installer [page 27].
Context

Software Provisioning Manager (the “installer” for short) offers two GUIs:

- The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
- The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

Note

If the SL Common GUI does not meet your requirements you can still use the “classic” Java SDT GUI. You then have to start the sapinst executable with the command line option

```
SAPINST_SLP_MODE=false.
```

In cases where both GUIs behave the same way, we address them as “installer GUI”.

For more information, see Useful Information About the Installer [page 37].

This procedure describes an installation where you use one of the following GUI scenarios:

- You run the installer and use the SL Common GUI. Then you can control the processing of the installer in the browser running on any device.
- You run the installer and use the Java SDT GUI. Both are running on the same host.

Procedure

1. Log on to the installation host using an account with the required user authorization to run the Installer [page 22].

   Caution

   Do not use an existing <sapsid>adm user.

   SL Common GUI only: If your security policy requires that the person running the installer is not allowed to know administrator credentials on the installation host, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting sapinst.exe from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

2. Start the installer by double-clicking sapinst.exe from the directory to which you unpacked the Software Provisioning Manager archive.

   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option

   ```
   SAPINST_BROWSER=<Path to Browser Executable>,
   ```

   for example

   ```
   SAPINST_BROWSER=firefox.exe.
   ```
1. Open a command prompt or PowerShell window in elevated mode and change to the directory to which you unpacked the Software Provisioning Manager archive.

2. Start the installer with the following command:
   - `sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name>` (in a command prompt)
   - `.\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual_Host_Name>` (in PowerShell)

3. The installer is starting up.

   Depending on the type of the installer GUI you want to use, do one of the following:

   - If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 27]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the Welcome screen.
     - If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

     **Sample Code**

     ```
     ...
     ******************************************************************************
     ******
     Open your browser and paste the following URL address to access the GUI
     https://[<hostname>]:4237/sapinst/docs/index.html
     Logon users: [<users>]
     ******************************************************************************
     ******
     ...
     ```

     The SL Common GUI opens in the browser by displaying the Welcome screen.

     **Note**

     Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

   - If you use the Java SDT GUI - that is you started the sapinst executable with command line option `SAPINST_SLP_MODE=false`, the Java SDT GUI starts automatically by displaying the Welcome screen.

4. On the Welcome screen, choose the required option:

   - If you are using the 70SWPM*.SAR:
     Choose your product, then go to Software Life-Cycle Options ➔ SAP Library Installation and Update ➔ Install/Update SAP Library
   - If you are using the SWPM*.SAR:
     Go to Generic Options ➔ <Database> ➔ SAP Library Installation and Update ➔ Install/Update SAP Library

5. Choose Next.
6. If the installer prompts you to log off from your system, log off and log on again. The installer restarts automatically.

7. Follow the instructions on the installer screens and enter the required parameters.

Note
To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field:
- If you use the SL Common GUI, choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.
- If you use the Java SDT GUI, choose F1. Then a dialog opens with the available help text.

Caution
The signature of media is checked automatically during the Define Parameters phase while processing the Media Browser screens.

Keep in mind that this automatic check is only committed once and not repeated if you modify artefacts such as SAR archives or files on the media after the initial check has been done - that is if you modify artefacts later on either during the remaining Define Parameters phase or later on during the Execute Service phase the signature is not checked again.

See also the description of this new security feature in SAP Note 2393060.

After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

8. To start the installation, choose Next.

The installer starts the installation and displays the progress of the installation. When the installation has finished, the installer shows the message: Execution of <Option_Name> has completed.

9. Java GUI only: For security reasons, we recommend that you delete the .sdtgui directory within the home directory of the user with which you ran the installer:

%userprofile%\sdtgui\n
10. If you copied the installer software to your hard disk, you can delete these files when the installation has successfully completed.
4 Post-Installation

The following sections provide information about activities after the installation of the SAP Library has finished successfully.

Related Information

Using a Web Browser or Viewer [page 32]
Offline Access to Help Files - SAP Library Navigation [page 33]
Setting Variants for SAP Library [page 34]

4.1 Using a Web Browser or Viewer

The HTML-based documentation can be displayed in a Web browser on all front-end platforms supported by SAP. However, you must observe certain requirements and restrictions depending on the specific platform. The following table shows which browsers can be used with which front-end platforms.

<table>
<thead>
<tr>
<th></th>
<th>HTML Help Viewer with Microsoft Internet Explorer 5.01 SP 2 (or higher)</th>
<th>Microsoft Internet Explorer 5.01 SP 2 (or higher)</th>
<th>Firefox Mozilla 2.xx</th>
<th>Netscape 4.06 (or higher)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>platforms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note the following points:

- If you are using HTML Help Viewer in Microsoft Windows, a new instance of the viewer or browser is opened each time you access help documentation.
- If you choose help type HtmlHelpFile, you must use HTML Help Viewer, which is based on Microsoft Internet Explorer and requires it. If you use help types PlainHtmlHttp and PlainHtmlFile you can use either Microsoft Internet Explorer or Netscape. For the help structure implemented with JavaScript and displayed as a compressed tree, JavaScript must be activated in both browsers.
Installation of Microsoft HTML Help Viewer and Microsoft Internet Explorer

Microsoft HTML Help Viewer is installed automatically when you install SAP GUI 7.10 from the DVD Presentation on your front-end PC (versions of file HH.exe older than 1.32 are overwritten).

Note that HH.exe (HTML Help Viewer) is also installed with Microsoft Internet Explorer, and therefore any version already installed might be overwritten.

Microsoft Internet Explorer is installed with the operating system. You can download updates from the Microsoft Web site. You can also download Microsoft Internet Explorer for Macintosh from the Microsoft Web site.

**Note**

To use the HTML Help Viewer, you have to activate ActiveX in the Microsoft Internet Explorer. In the Internet Explorer, choose security level **Medium** or **Low** under the **Local** intranet zone in the menu path **Tools** ➔ **Internet Options** ➔ **Security**.

For more information, see SAP Note 594271 and SAP Note 857216.

To display documentation on how to use HTML Help Viewer, choose **Help** in the **Viewer** toolbar.

### 4.2 Offline Access to Help Files - SAP Library Navigation

**Use**

To view the documentation offline – that is, without connecting to the SAP system – you need to:

- Install a suitable browser or viewer on your computer as described in table **Web Browser for Help Documentation** in Using a Web Browser or Viewer [page 32].
- Have access to the help files. For the standard HTML help files, this requires you to unpack the archive **PLAINHTM.SAR** from the DVD to your hard drive.

**Procedure**

**HtmlHelpFile: Offline Access to Help Files**

1. Navigate to the directory `<InstallDir>\HTMLHELP\<language key>` using the Microsoft Windows Explorer.
   
   This is the directory containing the help files.

2. Double-click on file `00000001.chm`.
   
   This opens SAP Library. From here you can navigate to all parts of the documentation.

3. Add the documentation homepage to your browser favorites or bookmarks.

**PlainHtmlHttp and PlainHtmFile: Offline Access to the Help Files**
1. Navigate to the directory `<InstallDir>\HTMLHELP\<language key>`. This is the directory containing the help files.
2. Open file `index.htm`. This loads the documentation homepage in your Web browser. From here you can navigate to all parts of the documentation.
3. Add the documentation homepage to your browser favorites or bookmarks.

### 4.3 Setting Variants for SAP Library

#### Use

In the IMG activity (transaction SR13), you specify which help variants you want to make available to users of the SAP system. For more information about the definition of setting variants, see the SAP NetWeaver Implementation Guide (IMG).

For more information about the HTTP protocol configuration, see SAP Note 1842462.

**Note**

On some front-end platforms, the URLs of the help files displayed in the browser must contain a local drive identifier assigned to the file server instead of the name of the file server itself (for example `file:///K:/PLAINHTM/710/EN/e1/8e51341a06084de10000009b38f83b/frameset.htm`). In this case, the entry in the Path field must start with a drive letter and not with the name of the file server. You must also make sure that this drive letter points to the file server on the front end.

#### Procedure

**Special Features of the Help Types**

**HtmlHelpFile**

The path names specified in the setting variants must not contain special characters such as blanks or ampersands. In addition, path names must not be longer than 64 characters.

**PlainHtmlHttp**

- Enter the name of the Web server including the port.
- Enter the path in the URL syntax. Path names must not contain special characters such as blanks or ampersands. In addition, path names must not be longer than 64 characters.

**PlainHtmlFile**

Use the syntax of the front-end platform when specifying a path name. Path names must not contain special characters such as blanks or ampersands. In addition, path names must not be longer than 64 characters.

**Assignment of the Disk Drive Letter to the File Server**
Table 9:

<table>
<thead>
<tr>
<th>Front End</th>
<th>Does the drive letter have to be assigned to the file server?</th>
<th>Front End</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>Only if Netscape Navigator is used</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>Apple Macintosh</td>
<td>Yes</td>
<td>Apple Macintosh</td>
</tr>
</tbody>
</table>

Example

Your front-end PC runs on Apple Macintosh and the help files reside in subdirectory `PLAINHTM\710\EN` of the shared directory `docu` on server `\p99999`. If the share name `\p99999\docu` is assigned to drive `K:` on the front ends, then the entry in the *Path* field must be `K:\PLAINHTM\710`.

Example

Table 10: Example for HtmlHelpFile: Setting Variant for the Help Documentation

<table>
<thead>
<tr>
<th>Variant</th>
<th>HTML Help 7.10 English</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>WN32</td>
</tr>
<tr>
<td>Area</td>
<td>IWBHELP</td>
</tr>
<tr>
<td>Path</td>
<td><code>\\p12345\HTMLHELP710</code></td>
</tr>
<tr>
<td>Language</td>
<td>EN</td>
</tr>
<tr>
<td>Default</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 11: Example for PlainHtmlHttp: Setting Variant for the Help Documentation

<table>
<thead>
<tr>
<th>Variant</th>
<th>HTML (Web) 7.10 English</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>WN32</td>
</tr>
<tr>
<td>Area</td>
<td>IWBHELP</td>
</tr>
<tr>
<td>Server</td>
<td><code>p12345:1080</code></td>
</tr>
<tr>
<td>Path</td>
<td>PlainHttp710</td>
</tr>
<tr>
<td>Language</td>
<td>EN</td>
</tr>
</tbody>
</table>

Table 12: Example for PlainHtmlFile: Setting Variant for the Help Documentation

<table>
<thead>
<tr>
<th>Variant</th>
<th>HTML (File) 7.10 English</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>WN32</td>
</tr>
<tr>
<td>Area</td>
<td>IWBHELP</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td>Path</td>
<td>\p12345\PlainFile710</td>
</tr>
<tr>
<td>Language</td>
<td>EN</td>
</tr>
<tr>
<td>Default</td>
<td>Yes</td>
</tr>
</tbody>
</table>
5  Additional Information

- About the Installer (Software Provisioning Manager) [page 37]
- Local Override of Help Settings on Front Ends [page 47]

5.1  About the Installer

5.1.1  Useful Information About the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- Software Provisioning Manager (the installer) offers two GUIs:
  - The new web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short
  - The “classic” Java-based GUI with a CUI client and server - “Java SDT GUI” for short

The SL Common GUI of the Software Provisioning Manager (or “SL Common GUI” for short) uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:

- Zero foot print, since only a web browser is required on the client
- New controls and functionality, for example, view logs in web browser.

The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.

For the SL Common GUI, the installer provides a pre-generated URL in the Program Starter window. If you have a supported web browser installed on the host where you run the installer, the SL Common GUI starts automatically.

By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option

\[ \text{SAPINST_BROWSER} = \langle \text{Path to Browser Executable} \rangle, \text{ for example} \]
\[ \text{SAPINST_BROWSER} = \langle \text{firefox.exe} \rangle. \]

Alternatively you can open a supported web browser on any device and run the URL from there.

For more information about supported web browsers see Prerequisites for Running the Installer [page 27].

If the SL Common GUI does not meet your requirements, you can still use the “classic” Java SDT GUI. To do so, you must start the sapinst executable with the command line option \[ \text{SAPINST_SLP_MODE} = \text{false}. \]

You can switch back to the default installer GUI at any time with the following steps:

1. Stop the installer.
2. Restart the installer with command line option \[ \text{SAPINST_SLP_MODE} = \text{false}. \]
3. On the What do you want to do? screen choose Continue with the existing run.

- The installer creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the %ProgramFiles% directory. If the installer is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.
For each option, the installer creates a subdirectory located in the *sapinst_instdir* directory.

The installer extracts itself to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after the installer has stopped running. Directories called *sapinst_exe.xxxxxx.xxxx* sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the log file *dev_selfex.out* from the extraction process, which might be useful if an error occurs.

**Caution**

If the installer cannot find a temporary directory, the installation terminates with the error FCO-00058.

To see a list of all available installer properties, go to the directory `%TEMP%\sapinst_exe.xxxxxx.xxxx` after you have started the installer, and enter the following command: 

`sapinst.exe -p`

**This information is only relevant if you use the Java GUI of the installer:** If you need to run the installer in accessibility mode, proceed as described in Running the Installer in Accessibility Mode [page 45].

If you want to install an SAP system in unattended mode, see SAP Note 2230669 which describes an improved procedure using `inifile.params`.

If required, stop the installer by choosing one of the following, depending on the installer GUI you use:

- In the SL Common GUI, choose the *Cancel* button.
- In the Java SDT GUI, choose *SAPinst Exit Process* in the Java SDT GUI menu.

**Note**

If you need to terminate the installer, choose *File Exit* in the menu of the *Program Starter* window.

### 5.1.2 Performing a Remote Installation (Java SDT GUI only)

Here you find information about how to install your SAP system on a remote host.

**Note**

This section is only valid if you use the Java SDT GUI. That is, you started the *sapinst* executable with command line option `SAPINST_SLP_MODE=false`.

**Prerequisites**

- The remote host meets the prerequisites for starting the installer as described in Prerequisites for Running the Installer [page 27].
- Both computers are in the same network and can ping each other.
  To test this:
  1. Log on to your remote host and enter the command: `ping <Local_Host>`
2. Log on to the local host and enter the command: `ping <Remote_Host>`

- If you need to specify another operating system user with the `SAPINST_REMOTE_ACCESS_USER` command line parameter, make sure that this user exists on the remote host.

**Context**

You use this procedure to install your SAP system on a *remote* host. In this case, the installer runs on the *remote host*, and the installer GUI runs on the *local* host. The local host is the host from which you control the installation with the installer GUI. The installer GUI connects using a secure SSL connection to the installer.

If your security policy requires that the person performing the installation by running the installer GUI on the local host is not allowed to know administrator credentials on the remote host, you can specify another operating system user for authentication purposes. You do this using the `SAPINST_REMOTE_ACCESS_USER` parameter when starting `sapinst.exe` from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note [1745524](#).

**Procedure**

1. Log on to the remote host as a user with the required authorization for running the installer.
   
   For more information, see [Required User Authorization for Running the Installer](#) [page 22].

2. Make the installation media available on your remote host.
   
   For more information, see [Preparing the Installation Media](#) [page 17].

3. Open a command prompt and change to the directory to which you unpacked the Software Provisioning Manager archive.

4. Check the version of the `sapinst` executable by entering the following command:

   ```
   sapinst.exe -sfxver
   ```

   The version of the `sapinst` executable must be exactly the same as the version of the `sapinstgui` executable on the local host (see also [Starting the Installer GUI Separately](#) [page 40]).

5. Start the installer by entering the following command:

   ```
   sapinst.exe
   ```

   The installer now starts and waits for the connection to the installer GUI. You see the following at the command prompt:

   ```
   guiengine: no GUI connected; waiting for a connection on host <Host_Name>, port <Port_Number> to continue with the installation
   ```

6. Start the installer GUI on your *local* host as described in [Starting the Installer GUI Separately](#) [page 40].
5.1.3 Starting the Java SDT GUI Separately

Here you find information about how to start the Java SDT GUI separately.

**Note**

This section is only valid if you use the Java SDT GUI. That is, you started the `sapinst` executable with command line option `SAPINST_SLP_MODE=false`.

**Prerequisites**

The host on which you want to start the installer GUI meets the prerequisites for starting the installer as described in *Prerequisites for Running the Installer [page 27]*.

**Note**

If you want to run the installer on a UNIX host, make sure that you meet the prerequisites for the installer listed in the relevant UNIX guide.

**Context**

You might need to start the installer GUI separately in the following cases:

- You closed the installer GUI using `File > Close GUI only` from the installer menu while the installer is still running.
- You want to perform a remote installation, where the installer GUI runs on a different host from the installer. For more information, see *Performing a Remote Installation (Java SDT GUI only) [page 38]*.

In the this procedure, the following variables are used: `<Remote_Host>` is the name of the remote host, and `<Port_Number_Gui_Server_To_Gui_Client>` is the port the GUI server uses to communicate with the GUI client (21212 by default).

**Procedure**

- **Starting the Installer GUI on Windows**
  a. Make the installer software available on the host on which you want to start the installer GUI.
  b. Start the installer GUI by executing the `sapinstgui` executable with the appropriate command line parameters:
     - If you want to perform a remote installation, proceed as follows:
       1. Check the version of `sapinstgui.exe` by entering the following command:
          ```
          <Path_To_Unpack_Directory>\sapinstgui.exe -sfxver
          ```
The version of the sapinstgui executable must be exactly the same as the version of the sapinst executable on the remote host (see also Performing a Remote Installation [page 38]).

2. Start the installer GUI by entering the following command:

   `<Path_To_Unpack_Directory>/sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`

   ○ If you closed the installer GUI using File Close GUI only and want to reconnect to the installer, proceed as follows:

   1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:

      `<Path_To_Unpack_Directory>/sapinstgui.exe -port <Port_Number_Gui_Server_To_Gui_Client>`

   2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:

      `<Path_To_Unpack_Directory>/sapinstgui.exe -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`

c. The installer GUI starts and connects to the installer.

- **Starting the Installer GUI on UNIX**
  
a. Make the installer software available on the host on which you want to start the installer GUI.

b. Start the installer GUI by executing the sapinstgui executable with the appropriate command line parameters:

   ○ If you want to perform a remote installation, proceed as follows:

   1. Check the version of the sapinstgui executable by entering the following command:

      `<Path_To_Unpack_Directory>/sapinstgui -sfxver`

      The version of the sapinstgui executable must be exactly the same as the version of the sapinst executable on the remote host (see also Performing a Remote Installation [page 38]).

   2. Start the installer GUI by entering the following command:

      `<Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`

   ○ If you closed the installer GUI using File Close GUI only and want to reconnect to the installer, proceed as follows:

   1. If you are performing a local installation with the installer and the installer GUI running on the same host, execute the following command:

      `<Path_To_Unpack_Directory>/sapinstgui -port <Port_Number_Gui_Server_To_Gui_Client>`

   2. If you are performing a remote installation with the installer and the installer GUI running on different hosts, execute the following command:

      `<Path_To_Unpack_Directory>/sapinstgui -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>`

c. The installer GUI starts and connects to the installer.
5.1.4 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:

- **An error occurred during the Define Parameters or Execute phase:**
  The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.

- **You interrupted the installation by choosing**
  - Cancel in the SL Common GUI
  - Exit Process in the SAPinst menu in the Java SDT GUI

⚠️ **Caution**

If you stop an option in the Execute phase, any system or component **installed** by this option is incomplete and not ready to be used. Any system or component **uninstalled** by this option is not completely uninstalled.

The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
</table>
| **Retry** | The installer retries the installation from the point of failure without repeating any of the previous steps.  
This is possible because the installer records the installation progress in the keydb.xml file.  
We recommend that you view the entries in the log files, try to solve the problem, and then choose Retry.  
If the same or a different error occurs, the installer displays the same dialog box again. |
| **Stop** | The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server.  
The installer records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below. |
| **Continue** | The installer continues the installation from the current point. |
| **View Log** | Access installation log files. |
The following procedure describes the steps to restart an installation, which you stopped by choosing Stop, or to continue an interrupted installation after an error situation.

**Procedure**

1. Log on to the installation host as a user with the required permissions as described in Running the Installer [page 28].
2. Make sure that the installation media are still available.
   For more information, see Preparing the Installation Media [page 17].

   **Recommendation**
   Make the installation media available locally. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.

3. Restart the installer by double-clicking sapinst.exe from the directory to which you unpacked the Software Provisioning Manager archive.
   By default, the SL Common GUI uses the default browser defined for the host where you run the installer. However, you can also specify another supported web browser available on the host where you start the installer. You can do this by starting the sapinst executable with command line option
   `SAPINST_BROWSER=<Path to Browser Executable>`, for example `SAPINST_BROWSER=firefox.exe`.
4. The installer is restarting.

   Depending on the type of the installer GUI you want to use, do one of the following:
   - If you use the SL Common GUI, the installer now starts and waits for the connection with the SL Common GUI. If you have a supported web browser (see Prerequisites for Running the Installer [page 27]) installed on the host where you run the installer, the SL Common GUI starts automatically by displaying the Welcome screen.
     If the SL Common GUI does not open automatically, you can find the URL you require to access the SL Common GUI at the bottom of the Program Starter window of the installer. You find the icon of the Program Starter window in the taskbar of your Windows host. Open a supported web browser and run the URL from there.

   **Sample Code**

   ```
   ******************************************************************************
   Open your browser and paste the following URL address to access the GUI 
   https://[<hostname>]:4237/sapinst/docs/index.html 
   Logon users: [<users>] 
   ******************************************************************************
   ```

   The SL Common GUI opens in the browser by displaying the Welcome screen.
i Note

Before you reach the Welcome screen, your browser might warn you that the certificate of the sapinst process on this computer could not be verified. Accept this warning to inform your browser that it can trust this site, even if the certificate could not be verified.

○ If you use the Java SDT GUI - that is you started the sapinst executable with command line option SAPINST_SLP_MODE=false, the Java SDT GUI starts automatically by displaying the Welcome screen.

5. From the tree structure on the Welcome screen, select the installation option that you want to continue and choose Next.

The What do you want to do? screen appears.

6. On the What do you want to do? screen, decide between the following alternatives and continue with Next:

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform a new run</td>
<td>The installer does not continue the interrupted installation option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: log_&lt;Day&gt;<em>/&lt;Month&gt;</em>/&lt;Year&gt;<em>/&lt;Hours&gt;</em>/&lt;Minutes&gt;_/&lt;Seconds&gt;</td>
</tr>
<tr>
<td>Example</td>
<td>log_01_Oct_2016_13_47_56</td>
</tr>
</tbody>
</table>

i Note

All actions taken by the installation before you stopped it (such as creating directories or users) are not revoked.

Caution

The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.

Continue with the existing one | The installer continues the interrupted installation from the point of failure. |
5.1.5 Running the Installer in Accessibility Mode

You can also run the installer in accessibility mode.

Note
The information contained in this section is only valid if you use the Java SDT GUI. That is, you started the sapinst executable with command line option SAPINST_SLP_MODE=false.
If you use the SL Common GUI, apply the standard accessibility functions of your web browser.

Context
The following features are available:

- Keyboard access:
  This feature is generally available for all operating systems.
- High-contrast color:
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.
- Custom font setting:
  This feature is derived from the Windows display properties. You can use it either for a local installation or for a remote installation.

Procedure

- Activating and Adjusting Accessibility Settings on Windows
You first have to activate and adjust the relevant settings for the font size and color schemes before you start the installer or the installer GUI.

  Note
  The following procedure applies for Windows Server 2012 and might be different when using another Windows operating system.

  a. Right click on your Windows desktop and choose Personalize.
  b. Select Adjust font size (DPI) and choose Larger scale (120 DPI).
     To define other font size schemes, choose Custom DPI.
  c. In the right-hand pane, select Window Color and Appearance.
     Select a color scheme from the Color scheme drop-down box.
     To define your own color schemes, choose Advanced.

- Running the Installer in Accessibility Mode
You can either perform a local installation, where the installer and the installer GUI are running on the same host, or a remote installation, where the installer and the installer GUI are running on different hosts.

- **Local installation:**
  
  ```
  <Path_To_Unpack_Directory>\sapinst.exe -accessible
  ```

- **Remote installation:**
  1. Start the installer on the remote host by executing the following command from the command line as described in Performing a Remote Installation (Java SDT GUI only) [page 38]:
  
  ```
  <Path_To_Unpack_Directory>\sapinst.exe
  ```
  2. Start the installer GUI on the local host by executing the following command from the command line as described in Starting the Java SDT GUI Separately [page 40]:
  
  ```
  <Path_To_Unpack_Directory>\sapinstgui.exe -accessible -host <Remote_Host> -port <Port_Number_Gui_Server_To_Gui_Client>
  ```

### 5.1.6 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

**Context**

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error

**Procedure**

1. Check SAP Note 1548438 for known installer issues.
2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   
   - Try to solve the problem:
     
     - To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose:
       
       - The LOG FILES tab, if you are using the SL Common GUI.
       - The View Logs menu item, if you are using the Java SDT GUI.

     - To check the log and trace files of the installer GUI for errors:
       
       - If you use the SL Common GUI, you can find them in the directory `%userprofile%\sapinst\`.
       - If you use the Java SDT GUI, you can find them in the directory `%userprofile%\sdtgui\`
         
         - If the GUI server or the installer GUI do not start, check the file sdtstart.err in the current `%userprofile%` directory.
         - If the installer GUI aborts without an error message, restart the installer GUI as described in Starting the Installer GUI Separately [page 40].
○ Then continue by choosing **Retry**.
○ If you cannot resolve the problem, abort the installer by choosing one of the following, depending on the type of installer GUI you use:
  ○ If you use the SL Common GUI, choose **Cancel** in the tool menu.
  ○ If you use the Java SDT GUI, choose **Stop** from the error message or **SAPinst** **Exit Process** in the tool menu.

For more information, see *Interrupted Processing of the Installer* [page 42].

3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*.

For more information about using subcomponents of BC-INS*, see SAP Note 1669327.

### 5.2 Local Override of Help Settings on Front Ends

You can override the help setting variants configured in the SAP system locally on Microsoft Windows front ends. This facility enables you to use a different help type and/or call help from a location other than defined in the setting variants defined by the system administrator.

**Note**

You can only override the local front ends if you have defined entries for the setting variants in transaction SR13. You must select a help type in transaction SR13.

### 5.2.1 File sapdoccd.ini

You enter override information in file **sapdoccd.ini**. You can store this file in the following locations:

- In the Microsoft Windows directory of the front-end PC (c:\Windows or c:\WINNT)
- In the SAP GUI directory (locally or on a server)
- In the parent directory of the SAP GUI directory

**Order of Evaluation**

Each time the user accesses help in the SAP system (**Help** > **Application Help**), the **sapdoccd.ini** file is evaluated in the Microsoft Windows directory of the front-end PC. If the file is not there, it is first searched for in the SAP GUI directory and then in the parent directory of the SAP GUI directory. If the file cannot be found or if it does not contain any override information for HTML-based help, the help processor copies the values of the setting variant of the SAP system currently in use. For more information, see *Setting Variants for SAP Library* [page 34]. To override the SAP system setting variant, look for a **sapdoccd.ini** file in the locations mentioned above and modify its content according to your requirements. Otherwise, create a new file with any ASCII editor (for example, Editor). Make sure you observe the order of evaluation if the file exists in more than one place.
Content and Format of sapdoccd.ini

The sapdoccd.ini file contains entries in Microsoft Windows INI format. The names of sections and parameters are not case-sensitive, but parameter values are.

**Note**
Apart from the settings for HTML-based help in systems with Release 4.0A and later, the sapdoccd.ini file can also contain control information for the WinHelp-based help in systems with Releases 3.xx. These settings do not affect each other.

5.2.2 Parameters in File sapdoccd.ini

The following parameters and parameter values can be used:

Table 15:

<table>
<thead>
<tr>
<th>HelpType</th>
<th>PlainHtmlHttp, PlainHtmlFile, HtmlHelpFile, DynamicHelp, GetFromR3</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;HelpType&gt;Server</td>
<td>Name of the Web server on which the files for &lt;HelpType&gt; reside</td>
</tr>
<tr>
<td>&lt;HelpType&gt;Path-&lt;language&gt;</td>
<td>Path to the help files for logon language &lt;language&gt; &lt;language&gt; is a two character language key.</td>
</tr>
<tr>
<td>&lt;HelpType&gt;Path</td>
<td>Path to the help files you want to display if no parameter &lt;HelpType&gt;Path-&lt;language&gt; is specified for the current logon language</td>
</tr>
</tbody>
</table>

**Note**
The help type DynamicHelp can only be used if SAP Knowledge Warehouse is installed. The help type GetFromR3 is not a proper help type. It is used to copy the values of the currently active setting variant of the SAP system. If you specify GetFromR3 as the help type (HelpType=GetFromR3), the settings from the SAP system are used. If you also specify the server and/or path in sapdoccd.ini, these settings override the settings in the SAP system. The paths used to override help settings locally must include the language key.
Validity Range of Parameters

You can specify the SAP systems to which the override applies by entering parameter values in the relevant sections in sapdoccd.ini. Entries for overriding the HTML-based help can apply to:

- **All SAP systems**
  Entries in section [HTMLHELP] apply to all SAP systems.

- **SAP systems with a specific release**
  Entries in sections [HTMLHELP-<Release>] apply to all SAP systems with this release. They override the entries in section [HTMLHELP].

- **Individual SAP systems**
  Entries in sections [SystemId-<SAP System>] apply to <SAP system> and override both the global entries in section [HTMLHELP] and the release-specific entries in sections HTMLHELP-<Release>.

- **If an entry for a particular release (for example, Release 7.10) specifies a language-specific path (<HelpType>Path<Language>), while an entry for a particular system with the same release specifies a generic path (<HelpType>Path), the release-specific entry applies.**

**Example**

```
[HTMLHELP] HelpType=PlainHtmlHttp
PlainHtmlHttpServer=p99999.sap-ag.de:1080
PlainHtmlHttpPath-DE=saphelp/DE
PlainHtmlHttpPath-EN=saphelp/EN

[HTMLHELP-710] HelpType=HtmlHelpFile
HtmlHelpFilePath-DE=\DWDF042\docu\710\HTMLHELP\DE
HtmlHelpFilePath-EN=\DWDF042\docu\710\HTMLHELP\EN
HtmlHelpFilePath=\DWDF042\docu\710\HTMLHELP\EN

[SystemId-B20] HelpType=HtmlHelpFile
HtmlHelpFilePath-DE=\p12345\HTMLHELP\DE
HtmlHelpFilePath=\p12345\HTMLHELP\EN

[SystemId-B40] HelpType=PlainHtmlFile
PlainHtmlFilePath-DE=\p44444\PLAINHTM\DE
PlainHtmlFilePath=\p44444\PLAINHTM\EN

[SystemId-B60] HelpType=GetFromR3
HtmlHelpFilePath-DE=\p99999\HTMLHELP\DE
HtmlHelpFilePath=\p99999\HTMLHELP\EN
```
5.2.3 Logging of Help Calls

A log for each call is written to the file sapdoccd.log.

The log file contains the following information, separated by spaces:

- Command line used to launch the start program for help (SHH.EXE) from the SAP system
- Default parameters (transaction SR13) extracted from the command line
- Parameters extracted from the file sapdoccd.ini
- Start parameters resulting from the previous two points
- Browser/viewer version (for help type HtmlHelpFile only)

The following is an example of a log produced when application help is launched from an SAP system called B20:

```
SHH version = 4.5.2.1
command line = TYPE=2&SERVER=p99999.sap-ag.de:1080&PATH=saphelp/EN
&SYSTEM=B20&_CLASS=IWBM.EXITHELP
&LOIO=a4d47db49e111d189730000e8322d00
&_SLOIO=a4d480e47e111d189730000e8322d00
&LANGUAGE=EN&RELEASE=710
&W_COUNTRY=W&IWBM_ID=I

info: --- default settings from command line ---
info: HelpType=PlainHtmlHttp
info: PlainHtmlHttpServer=p99999.sap-ag.de:1080
info: PlainHtmlHttpPath=saphelp/DE

info: --- contents of profile "C:\WINNT\sapdoccd.ini" ---
info: HelpType="HtmlHelpFile"
info: HtmlHelpFilePath-EN="\p12345\HTMLHELP\EN"

info: --- starting HtmlHelp ---
info: ini file="\p12345\HTMLHELP\EN\htmlhelp.ini"
info: chm file="\p12345\HTMLHELP\EN\00000619.chm"
info: html file="/c21ea0b446011d189700000e8322d00/content.htm"

info: --- version info ---
info: Microsoft Internet Explorer version is 4.7.0.1300
info: Microsoft HTML-Help version is 4.73.8474.0
```

Figure 1: Log Example

In the example, help type HtmlHelpFile is used and the help files are accessed from the directory \HTMLHELP\EN on the file server \p12345. If you launched the help documentation from the SAP system B40, the help type PlainHtmlFile is used. In all other SAP systems, the default help type PlainHtmlHttp (defined in transaction SR13) is used.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).

Open Source Software and Third Party Components

Please refer to https://scn.sap.com/docs/DOC-42044 for information respecting open source software components made available by SAP as part of SAP NetWeaver and any specific conditions that apply to your use of such open source software components. Please refer to https://scn.sap.com/docs/DOC-42045 for information relating to SAP's use of third party software with or within SAP NetWeaver.